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Introduction 
 
 What is Connected Books?   
 
Connected Books is an online tool designed to aid HDFCs in maintaining the finances of their 
buildings.   
 
Connected Books can be accessed only through an Internet connection.  This includes telephone 
modem dial up, cable modem, DSL, LAN, and other high-speed connections.   
 
Connected Books can be found on the world wide web (internet) at the following web address: 
http://www.connectedbooks.coop 
 
 
 About UHAB 
 
The Urban Homesteading Assistance Board supports self-help housing and community building 
in low-income neighborhoods by training, organizing, developing, and assisting resident-
controlled limited equity housing co-operatives.  In New York City, we’ve helped create the 
nations largest community of limited-equity affordable co-operatives.  Please refer to 
www.uhab.org to learn more about UHAB and our work.   
 
 

UHAB Member Services 
 
UHAB Member Services provides HDFC and TIL buildings access to cost-saving programs and 
news updates designed to help buildings run smoothly and at the lowest possible cost.  Member 
Services include the Fire and Liability Insurance Plan (FLIP), our high quality and competitively 
priced insurance designed specifically for HDFCs, and UHAB Fuel, which offers buildings 
heating fuel oil at extra low prices.  To learn more about Member Services please contact Emily 
Ng at 212-479-3318 or at ng@uhab.org.  

 
 

UHAB Digital Programs 
 
UHAB’s digital programs provide quality, network based services to a growing and changing 
population of HDFC leaders. Besides Connected Books, there are nearly a dozen other tools 
available to HDFCs at www.connectedbooks.coop including useful links like the Vendor 
Directory, the online library, forums, and free email. 
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Web Browser Requirements and Settings 
 
You can log into Connected Books on any browser; however some may inhibit or make more 
difficult the use of certain features.  The following browsers are preferred: 
 
Mozilla Firefox, version 3 or later 
 
Safari, version 3 or later 
 
Both browsers are available for both PC and Mac.  To download the most recent versions of the 
internet browser, visit the following pages: 
 
For Mozilla Firefox, go to:  http://www.mozilla.org/ and choose the appropriate link  
 
For Safari, go to:  http://www.apple.com/safari/download/ 
 
In order to access all features of Connected Books, you will have to make sure that your browser 
is set correctly.  You will need to make sure that pop-up window blocking is tuned off and that 
the status bar (the strip at the bottom of the screen) is showing correctly.   
 
For Firefox:  
 

1. Go to the “Tools” menu at the top of the screen and select “Options…” (it will be the last 
item in the menu) 

2. A window will open up with several icons along the top.  Click on the third from left, 
labeled “Content.” 

3. A list of four options will appear with boxes you can check or uncheck in the top portion 
of the window.  Make sure that “Block Pop-up Windows” is unchecked and that “Enable 
JavaScipt” is checked. 

4. Click on the button to the right labeled “Advanced.” 
5. A new window will pop up.  Make sure “Hide the status bar” is unchecked and that 

“Change status bar text” is checked. 
 
For Safari: 
 

1. Go the the “Edit” Menu at the top of the screen.  The second-to-last item on the menu 
reads “Block Pop-Up Windows.”  Make sure this does not have a check next to it.  If it 
does, click on it and the check should disappear. 

2. Go to the “View” menu at the top of the screen (directly to the right of the “Edit” menu). 
Select “Show status bar.”  If the status bare is already showing (a grey bar at the bottom 
of the screen) this item will read “Hide status bar.”  If this is the case, leave it as it is. 
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Contact Information 
 
 
Connected Books Help: cbhelp@connectedbooks.coop  
 
Brian Salfas   212-479-3355/salfas@uhab.org 
 
Emily Ng     212-479-3318/ng@uhab.org 
 
Venecia Velez   212-479-3321/velez@uhab.org 
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TERMS AND CONDITIONS FOR CONNECTED BOOKS 
 
 

THIS AGREEMENT is entered into this date ______________________________, by 
and between THE URBAN HOMESTEADING ASSISTANCE BOARD (hereinafter “UHAB”), 
having a principal place of business at 120 Wall Street, 20th Floor, New York, NY  10005, and 
________________________________________ ("Subscriber"). 
                   (Name of Building) 
 

WITNESSETH: 
 
 WHEREAS, UHAB is a Private, Not-for Profit Organization with the sole mission and 
purpose of assisting limited-equity cooperatives by offering training and technical assistance, and 
has created and developed a software based Internet service called “CONNECTED BOOKS” 
(hereinafter the “Service”) that is intended to manage the bookkeeping and financial planning for 
a cooperative.  The Service allows the user to record cash transactions and provides analyses of 
financial data that can be viewed and printed in report form. 
 

WHEREAS, UHAB and Subscriber believe it is in their mutual interest and desire to 
enter into an agreement for Subscriber to subscribe to UHAB’s Service under these terms and 
conditions. 

 
1. Services 

 
A. UHAB shall provide Subscriber with access to the Service through the Internet, in connection 
with financial recordkeeping and reporting for Subscriber’s cooperative. 
 
B. Access to the Service is expressly limited to use for the finances of a single building owned 
by Subscriber and may not be used for any other purpose. 
 
C. Subscriber shall be responsible for obtaining a computer and access to the Internet through 
which it can access the Service.   
 
D. UHAB reserves the right to make changes to the Service that affect Subscriber’s use of the 
Service.  However, UHAB shall not make changes to the Service which effect only Subscriber.  
Any improvements or modifications made by UHAB to the Service shall be provided to 
Subscriber as they are implemented in the Service, and the Service as modified shall be 
automatically covered by this Agreement.   
 
E. Subscriber shall not attempt to reverse engineer the Service. 
 
F. UHAB is not responsible for backing-up any data stored by Subscriber on the Service.  
SUBSCRIBER MUST SAVE, PRINT AND RETAIN COPIES OF REPORTS FROM THE SERVICE 
THAT IT WANTS TO PROTECT.  Subscriber acknowledges that UHAB shall have no liability 
for loss, damage, or destruction of Subscriber’s data. 
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2. TERM 
 

This Agreement shall be effective when it is signed by both parties and shall extend for a 
period of one (1) year (the “Initial Term”).  This Agreement shall automatically renew for 
additional one-year extensions unless Subscriber notifies UHAB in writing at least thirty (30) 
days prior to the expiration of the then-current Term that it intends not to renew the Agreement. 

 
 

3. CONFIDENTIALITY 
 

A. Subscriber recognizes that the Service, including the software, training materials, and other 
documentation concerning the Service (“Proprietary Information”), is the proprietary and 
confidential property of UHAB.  Accordingly, Subscriber shall not, without the prior express 
written consent of UHAB, disclose to any third party or utilize for its own benefit other than 
pursuant to this Agreement, Proprietary Information.  Subscriber further agrees to take 
reasonable precautions to preserve the confidentiality of the Proprietary Information.  
Subscriber’s obligations under this Paragraph shall not apply to:  (i) information now in the 
public domain; (ii) information already known to Subscriber without restriction prior to receipt 
from UHAB; (iii) information Subscriber receives from any third party having a legal right to 
transmit such information; or (iv) information independently developed by the Subscriber or its 
employees or agents, provided that the Subscriber can demonstrate that those same officers or 
agents did not have access to the Service.  The provisions of this clause shall survive termination 
of this Agreement.   
 
B. UHAB shall have the right to access Subscriber’s database information for the purpose of 
monitoring usage and for program and database maintenance.  Such access will not unreasonably 
interfere with the operation of the Service.  UHAB shall keep these financial records 
confidential, except to the extent that disclosure is necessary to resolve any dispute between the 
parties or to comply with the requirements of taxing or other governmental authorities. 
 
C. Subscriber understands and consents to the use of data provided to or collected by UHAB to 
be used in the aggregate for tracking and research purposes. 
 

4. TRAINING & SUPPORT 
 
A. There will be mandatory training in the form of classes or one-on-one sessions at UHAB.  
This training is necessary in order to help Subscriber set up its building and information in the 
Service.  Subscriber must attend these training sessions as required by UHAB. 
 
B. UHAB will provide Subscriber with a user manual for the Service, as well as contact 
information if Subscriber needs technical support for the Service or has bookkeeping related 
questions following the training.  
 
C. UHAB will provide a list of guidelines (see Rider A) to be adhered to by Subscriber. Failure 
to adhere to Rider A may result in Termination/Suspension of the Service pursuant to Section 6. 
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5. NO REPRESENTATIONS & WARRANTIES 
 
 SUBSCRIBER ACCEPTS THE SERVICE AS IS.  UHAB HEREBY DISCLAIMS ALL 
WARRANTIES, EXPRESS OR IMPLIED AND STATUTORY, INCLUDING, WITHOUT 
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT OF THIRD PARTY 
RIGHTS, AND SHALL HAVE NO LIABILITY (INCLUDING INCIDENTAL, INDIRECT 
AND/OR SPECIAL DAMAGES) WHATSOEVER TO SUBSCRIBER UNDER THIS 
AGREEMENT OR OTHERWISE RELATED TO THE SERVICE OR THE OPERATION OF 
THE SERVICE.  NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY UHAB 
OR ITS AGENTS OR EMPLOYEES SHALL IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY.  PRIOR TO SIGNING THIS AGREEMENT, SUBSCRIBER HAS HAD 
AN OPPORTUNITY TO EVALUATE THE SERVICE AND ALL RISK ASSOCIATED WITH 
THE EVALUATION OF THE SERVICE IS THAT OF SUBSCRIBER.  

SUBSCRIBER RETAINS THE RESPONSIBILITY FOR THE FRAUD AND/OR 
MISREPRESENTATION OF THE COOPERATION’S FINANCIAL SITUATION AND 
FAILURE TO PROVIDE BACKUP FOR ENTERING FRAUDULENT INFORMATION. 
 
 

6. TERMINATION/SUSPENSION 
 

A. RIGHT TO TERMINATE IN GENERAL. Subscriber may terminate this Agreement at 
any time on thirty (30) days written notice for any reason. UHAB may terminate this Agreement 
at any time on thirty (30) days written notice for any reason. 
  
B. RIGHT TO SUSPEND ACCESS. UHAB shall have the right to suspend Subscriber’s access 
to the Service and its data if Subscriber fails to comply with any of the terms of this Agreement 
or Rider A.   
 
 

7. POSTTERMINATION RIGHTS 
 

A. Upon the expiration or termination of this Agreement, all rights granted to Subscriber under 
this Agreement shall forthwith terminate and immediately revert to UHAB and Subscriber shall  
discontinue all use of the Service. 
 
B. Provided that UHAB does not terminate this Agreement due to Subscriber’s breach, upon 
expiration or termination UHAB shall assist Subscriber in downloading on to a CD all 
accounting and bookkeeping data related to Subscriber’s account, at no charge to the Subscriber 
(although there may be expenses associated with computer access, media, Internet access or 
printing for which Subscriber is responsible).   
 
C. Upon expiration or termination of this Agreement, Subscriber shall keep any materials 
associated with the Service confidential pursuant to Paragraph 4.  
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8. INDEMNITY 
 
 Subscriber agrees to defend, indemnify, and hold UHAB, and its officers, directors, 
agents, and employees, harmless against all costs, expenses, and losses (including reasonable 
attorney fees and costs) incurred through claims of third parties against UHAB based on a breach 
by Subscriber of this Agreement or in connection with the operation or management of 
Subscriber’s building. UHAB is also not liable for misrepresentation or fraud in the event that 
Subscriber enters fraudulent information pertaining to the HDFC’s finances.  
 

9. NOTICES 
 
A. Any notice required to be given pursuant to this Agreement shall be in writing.  
 
B. Either party may change the address to which notice or payment is to be sent by written notice 
to the other party pursuant to the provisions of this paragraph. 
 

10. JURISDICTION AND DISPUTES 
 
A. This agreement shall be governed by the laws of New York. 
 
B. All disputes hereunder shall be resolved in the applicable state or federal courts of New York.  
The parties consent to the jurisdiction of such courts, agree to accept service of process by mail, 
and waive any jurisdictional or venue defenses otherwise available. 
 

11. WAIVER 
 

 No waiver by either party of any default shall be deemed as a waiver of any prior or 
subsequent default of the same or other provisions of this Agreement. 
 

12.       SEVERABILITY 
 

 If any provision hereof is held invalid or unenforceable by a court of competent 
jurisdiction, such invalidity shall not affect the validity or operation of any other provision and  
such invalid provision shall be deemed to be severed from the Agreement. 

 
13. AGREEMENT BINDING ON SUCCESSORS 

 
This Agreement shall be binding on and shall inure to the benefit of the parties hereto, 

and their heirs, administrators, successors, assigns. 
 
 
 
 
 
 
 
 



 11

14. ASSIGNABILITY 
 

 The service granted hereunder is personal to Subscriber and may not be assigned by 
Subscriber or by operation of law unless in connection with a transfer of substantially all the 
assets of Subscriber or with the consent of UHAB. 
 
 

15. INTEGRATION 
 

 This Agreement constitutes the entire understanding of the parties, and revokes and 
supercedes all prior agreements between the parties and is intended as a final expression of their 
Agreement.  It shall not be modified or amended except in writing signed by the parties hereto 
and specifically referring to this Agreement.  This Agreement shall take precedence over any 
other documents that may be in conflict therewith. 
 

 
16. TAXES AND GOVERNMENT LICENSES 

 
 Subscriber, as a tax exempt Housing and Development Finance Corporation (“HDFC”), 
is exempt from paying any related taxes herein. 
 
The signatures below verify that both parties have read and agreed to the above mentioned 

terms and conditions. 
 
 IN WITNESS WHEREOF, the parties hereto, intending to be legally bound hereby, have 
each caused to be affixed here its or her/his hand and seal the day indicated. 
 
 (Name of UHAB REP)    (Name of SUBSCRIBER REP) 
 
BY:______________________    BY: ___________________ 
Title: _____________________   Title: __________________ 
Date: _____________________                         Date: __________________ 
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      RIDER A: EXPECTATIONS FORM 
 

Persuant to Terms and Conditions, this form lists the responsibilities Subscriber/HDFC has upon signing up for 
Connected Books.  
 
The responsibilities of the Subscriber and the Subscriber’s appointed Bookkeeper are as follows: 
 

• Regular deposits of checks written to the HDFC.  
 

• Regular preparation of checks to be signed by 2 officers at the board meeting and regularly dealing with 
emergency check requests. 

 

• Input of data about the HDFC’s financial activity (e.g. checks, deposits, resident charges, etc.) at least once 
every month. 

 

• Print reports (e.g. Rent Roll Report, Income and Expense Statement Report, Customer History Report, etc.) 
every month in order to insure that Board Members and Shareholders may regularly view the data. OR set up 
User Profiles for Board Members and Shareholders that they may regularly log in and view the reports. 

 

• Communicate monthly with all residents about their maintenance payments or rent arrears by using receipts 
with arrears marked  and/or the Customer History Report in Connected Books.  

 

• Communicate with Section 8, SCRIE, DRIE, and Public Assistance about maintenance increases for units 
receiving assistance, Section 8 or Public Assistance checks that are lost or not received, etc. 

 

• Update relevant information in Connected Books regarding maintenance or rent increases, residents moving 
in/out, changing units, etc.  

 

• Complete a monthly Reconciliation in Connected Books to verify the financial information with the bank 
statements.  

 

Subscriber and the Subscriber’s appointed Bookkeeper understand: 
 

• UHAB retains the right to terminate the Service for HDFCs dealing with direct cash transactions; including but 
not limited to: accepting rent and maintenance payments in cash or checks written to cash or checks written to 
individual Board Members without back up documentation and a board resolution. UHAB also retains the right 
to terminate the Service for HDFCs that use ATM cards, withdraw cash from Bank Accounts or write checks 
for petty cash to pay for expenses. Furthermore, it is not acceptable that the checks written to the Board 
Member for the HDFCs expenses are signed by the same Board Member. 

 

• NO Rent Credits can be issued unless backed by a Board Resolution or a Court Stipulation. UHAB 
recommends that the HDFC keep records of all paper work associated with the Board Resolution or Court 
Stipulation.  

 

The names and signatures below attest that the Board has approved the use of Connected Books as a tool for 
keeping track of the HDFC’s finances. The undersigned; accept and agree to the expectations and 
responsibilities listed above.  
 
_____________________________      __________________        _________________         _____________ 
                (Name of Bookkeeper)                                       (Position)                             (Signature)                                    (Date) 
_____________________________      __________________        _________________         _____________ 
                      (Name)                                                          (Position)                             (Signature)                                    (Date) 
_____________________________      __________________        _________________         _____________ 
                      (Name)                                                          (Position)                             (Signature)                                    (Date) 
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Introduction to Using Connected Books 
 
Connected Books takes all of the steps that you go through in basic bookkeeping, and puts them 
into an easy-to-use online program.  The result is a program that allows you to maintain your 
building’s finances with ease.   
 
What does Connected Books do for you? 
 

• keeps track of the income and expense transactions (checks, rent and maintenance 
deposits), reconciliation, and tenant and building information that you enter, and 
generates reports based on that information.   

• Connected Books takes the headaches out of financial tracking by storing the information 
on our servers, to be accessed when you log in to your building account.  

• You can easily generate, view, search, and print financial reports for your records, in the 
tax preparation season, or to be distributed to board members and shareholders. 

 
This software was designed with HDFCs in mind, to aid in maintaining your building’s 
finances.   
 
Connected Books was fine-tuned to the needs of buildings such as your own, and includes real-
to-life scenarios such as differentiating between tenants paying maintenance income and tenants 
who are renters and not shareholders; and includes section 8 income, and commercial income. 
 
Connected Books is easy to use, and manages all of your financial information once you 
enter the data/ information.   
 
You can easily search through specific fields such as residents or units, generate reports and 
summaries of your financials, reconcile your account with the bank statements, and do financial 
planning such as budgeting.  All of the functions of bookkeeping are included, plus more, in a 
user-friendly interface that’s been tested by trial users in HDFC buildings and by UHAB staff. 
 
Some of the user-friendly features of Connected Books include: 
 

• Reminders 
This unique feature notifies users of important dates such as board meetings, upcoming 
elections, and due dates for bills.  Connected Books helps keep track of those important 
dates and will generate a reminder when you log in to your account. 

 
• Generating reports and summaries 

Connected Books can put together Rent Roll reports, Customer History reports, and 
Income and Expense Statements.  Viewing and printing these reports and statements 
makes tracking your financials and presentation easy. 

 
• Financial Planning 

Features such as Budgeting and viewing a Financial Snapshot allow you to monitor and 
maintain a healthy financial state for your HDFC. 
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• User set-up 
Connected Books can be set up to allow as many users as you want to access your 
financial information; it can be set up so the information can be viewed and not edited.  
For example, a Bookkeeper that’s helping you do tax preparation can view financial 
records without being able to change the information that is stored.  This option helps 
greatly increase transparency in financial matters, and allows the treasurer the ability to 
share information. 

 
Consistent look of software:  Every screen of Connected Books has been formatted to look 
similar.  The following features have been included to make it easier to navigate through the 
software and get around easily: 
 

• MM (Main Menu) icon: Allows you to return to the Main Menu from the current screen.  
To view the Main Menu page, see page 19. 

 
• Search:  Clicking on Search brings you to a page where you can view all transactions in 

that section.  In some instances, you can specify what terms or keywords you are 
searching for within the function.  For more on Searching, see page 99. 

 
• Help: Get descriptions for functions and commands of the current screen. 
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Using the Manual 
 
This User Manual will help you navigate through the Connected Books application on your own 
with the following easy-to-use functions:   
 
Step-By-Step Commands.  For each section of the Connected Books software, commands will 
be written out in the User manual in the following format (to see a complete version of how to 
add a bill go to page  xx): 
 
Example: How do I add bill reminders for myself? 

Under the “Banking” heading in the Main Menu 
 click on “Bills”  
 click on “Add Bill” (If you are adding a bill for the first time  you will get a message 

stating so; click on the “Click Here” link to add a bill) 
 [enter in bill data including vendor, due date, amount, memo, account  

information]  
 
Visual Commands. In addition to the written instructions, visuals of “screen shots” of the 
software will be found throughout this manual.  
The following screen shots illustrate the “Adding Bill Reminders” command described above. 
 

 
Screen shots will be accompanied by yellow text boxes which contain information explaining the 
options within that screen. 
 
Important Notes! These appear throughout the Manual with important reminders. 

In the Main Menu, under 
the “Banking” heading, 
click on Bills to add a bill 
or a bill reminder. 

NOTE: These yellow and orange text boxes contain important 
information pertaining to the sections in which they appear. 
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Using Connected Books 
 
1. Getting Started 
 
Connected Books can be found on the internet at the following address: 
 
 http://www.connectedbooks.coop 
 
In order to use Connected Books for the first time, you must subscribe to Connected Books and 
work out the following: 

- sign the User Agreement 
- arrange payment billing information with UHAB staff  
- have a profile (username and password) created by UHAB staff 

 
Once your profile has been created, you are ready to use Connected Books. 
 
 
2. Logging In 
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3. Main Menu Screen 
 
The Connected Books Main Menu page is set up into 4 areas:  

 
 Banking  Analysis  Set Up  Administration. 
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Banking with Connected Books 
 
In this section, we will go over the functions for  

• Bills  
• Checks 
• Deposits 
• Resident Charges 
• Balance Transfer 
• All Cash Transactions 
• Reconciling 
• Month-End Closing 

 
 
Adding Bills 
 
 
 
 

 
 
 
Under the “Banking” heading in the Main Menu 

 click on “Bills”  
 click on “Add Bill”  

 
(If you are adding a bill for the first time you will get a message stating so; click 
on the “Click Here” link to add a bill) 
 

 Enter data including vendor, due date, amount, memo, account information 
 

 
 
 
 
 

 
 
 
 

 click on “Add” button 
 You will get a screen confirming that the Bill was added. 

 
 
 
 
 

NOTE: If you need to add a new vendor that is not on the pull-down menu, 
choose “Add vendor.”  A new window will open and require you to enter the 
vendor information (Company Name, First Name Last Name, and type of 
account.  A message screen will appear confirming that the vendor 
information was added; close that window.  In the original window, the 
vendor information will appear in the pull-down menu.

NOTE: Please note that entering your bills into Connected Books will 
not allow you to make payment online; it simply creates a reminder for 
you to make those bill payments in a timely manner. 
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The following screen shots illustrate the “Adding Bill Reminders” command described above. 

 
 

 
 

In the Main Menu, under 
the “Banking” heading, 
click on Bills to add a bill 
or a bill reminder. 

A message screen will 
appear if you have no 
bills, or are entering bills 
for the first time.  Click on 
the “Click Here” link. 
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If you have 
entered bills 
before, a menu 
of your bills 
will appear.   
Click on  
“Add Bill” to 
enter a bill. 

Use the pull down 
boxes here for for: 
 
Selecting the vendor 
 
Choosing the 
account the bill 
goes into. 

As always, scroll down 
and click on the “Add” 
icon to save your bill. 
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A message screen will 
appear confirming that the 
bill information has been 
added. 

To add a new vendor, 
choose “Add Vendor” 
on pull-down menu.  
A new window will 
open.  After new 
vendor information is 
added, a message 
screen will appear 
confirming that; close 
that window.  On the 
original window, you 
can then choose the 
vendor information 
from the pull-down 
menu. 
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Bill Reminders screen 
 
When you first log into Connected Books, your bills and reminders will automatically pop up 
and you will be asked for an acknowledgement of the reminders.  You must click on the 
‘acknowledge’ button, and until you do, you will not be able to move past this reminder screen.   
 

 
 
 
Paying Bills 
 
Paying bills will remove it from the Bills section and stop the reminders.   
 

 
 
 
Under the “Banking” heading in the Main Menu 

 click on “Bills”  
 When you see your list of Bills, click on “Pay Bill” next to the bill you are paying 
 Enter date and check number  

 (*Note that check number automatically appears as the next in the sequence). 
A dialogue box will pop up and ask “Are you sure you want to pay this bill?” 

 Click “OK” 
 
The bill will be removed from the list of bills, and placed into the Checks section. 
 

NOTE: Once you pay a bill, it is moved to the Checks section of Connected Books. 
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Adding Checks  
 

Under the “Banking” heading in the Main Menu 
 click on “Checks”  
 click on “Add Check” (If you are adding a check for the first time  you will get a 

message stating so; click on the “Click Here” link to add a check) 
 Use the “Check Maintenance Form” to record in all checks as they are written (enter  

in check information including vendor, check number, date, amount, memo).  
 Enter account information in the grey table.  Account information should appear  

automatically for vendors that have been entered.  Enter amount and memo. 
 
 
 

 
 
 
 
 
 
 

 click on “Submit” button 
You will get a screen confirming that the Check was added. 
 
 

   

Add a check by 
clicking on this 
icon. 

NOTE: If you need to add a new vendor that is not on the pull-down 
menu, choose “Add Vendor.”  A new window will open and require 
you to enter the vendor information (Company Name, First Name Last 
Name, and type of account).  A message screen will appear confirming 
that the vendor information was added; close that window.  On the 
original window, the webpage will refresh to show that the vendor 
information was added.  You can then choose the vendor information 
from the pull-down menu. 


